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Android Phones

Sony X10

Motorola CliqHTC G1 HTC HeroSamsung i7500

Motorola DroidHTC Magic HTC Tattoo
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Open Handset Alliance

 OHA(Open Handset Alliance) is a group of 71 
technology and mobile companies, including Google, 
Intel, Dell, HTC and China Mobile…

 Google announced the Open Handset Alliance and the 
Android platform in November of 2007  releasing the Android platform in November of 2007, releasing the 
first beta version Android Software Development Kit 
(SDK) at the same time( )
• Within a matter of a few months, over 1 million people 

had downloaded versions of the SDK
OHA’  i OHA’s aim
• Accelerate innovation in mobile phones
• Offer consumers a richer  less expensive  and better Offer consumers a richer, less expensive, and better 

mobile experience
 Google is the ‘captain’
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What’s Android

 Android is a software stack for 
mobile devices that includes an 
operating system, middleware and 
key applications 

 Android is based on JAVA and all  Android is based on JAVA and all 
its applications are developed in 
JAVA

 The JAVA VM, known as Dalvik, is 
highly customized and optimized 
f  bil  d ifor mobile devices

 Android SDK offers rich tools for 
android application development android application development 
and many useful APIs
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Android Features

 Application framework enabling reuse and replacement of 
components 

 Optimized Java virtual machine: Dalvik
 Optimized Graphics Processing, supporting 2D and 3D 

graphics(OpenGL ES 1 0 )graphics(OpenGL ES 1.0 )
 Integrated open source web browser: WebKit
 SQLite for structured data storage
 Multimedia capability, supporting varieties of audio, video 

and still image formats
 Bluetooth  GSM  EDGE  3G and Wi Fi support Bluetooth, GSM, EDGE, 3G and Wi-Fi support
 Camera, GPS, compass, accelerometer and other sensors
 Rich development environment, including an emulator, p , g ,

debugging tools, memory probe tools, log tools and eclipse 
plugins
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Android Architecture
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Libraries

 System C library, the standard C system library, tuned for 
embedded Linux-based devices

 Media Libraries, support playback and recording of many 
popular audio and video formats, as well as image files, 
including MPEG4, H.264, MP3, AAC, AMR, JPG, and PNGg , , , , , ,

 Surface Manager, manages access to the display 
subsystem and seamlessly composites 2D and 3D graphic 
layers from multiple applicationslayers from multiple applications

 WebKit, a modern web browser engine which powers both 
the Android browser and an embeddable web view

 SGL, the underlying 2D graphics engine
 3D libraries, an implementation based on OpenGL ES 1.0 

APIsAPIs
 FreeType , bitmap and vector font rendering
 SQLite , a powerful and lightweight relational database 
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Android Runtime

 The core of Android platform
 Dalvik Virtual Machine (VM)( )

• Executes files in Dalvik
Executable (.dex) format

b Java core Libraries
• Provides most of the functionality of the Java language

 How many Dalvik VMs? How many Dalvik VMs?
• Multiple Dalvik VMs may run at the same time
• Every Android application runs in its own process, with e y d o d app cat o u s ts o p ocess, t

its own instance of the Dalvik virtual machine

DVM JVM  Slow CPU
Google Sun
Dalvik Executable Java Bytecode
S bset of standard Ja a

Slow CPU
 Little RAM: 64Mb 

total, ~10Mb available 
at runtime
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Application Framework

 Simplify the reuse of components
• Applications can publish their capabilities and any other pp p p y

application may then make use of those capabilities
 Applications is a set of services and systems, include 

A ti it  M  th  lif l  f li ti  • Activity Manager, manages the lifecycle of applications 
and provides a common navigation back stack

• Notification Manager, enables all applications to g , pp
display custom alerts in the status bar

• …
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Application Framework

• …
• Resource Manager, providing access to non-code 

resources such as localized strings, graphics, and layout 
files

• Content Providers  access data from other applications Content Providers, access data from other applications 
(such as Contacts), or to share their own data

• Views, used to build an application, including lists, 
id  t t b  b tt  d   b dd bl  b grids, text boxes, buttons, and even an embeddable web 

browser

 Activity Manager, manages the lifecycle of applications 
and provides a common navigation backstackand provides a common navigation backstack

 …
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Applications

 A set of core applications shipped with Android 
platform
• E-mail client, SMS program, calendar, maps, browser, 

contacts, and others
 All written in Java using Google SDK All written in Java using Google SDK

 There is no difference between the built-in  There is no difference between the built-in 
applications and applications created with SDK
• Application framework encourages reuse of application 

components
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Applications

 Applications are bundled into an Android PacKage
(.apk files) which are archives containing the compiled 
code, data and resources for the application, so 
applications are completely self-contained

 You can install applications either through a market 
(Google Play Store, Amazon Appstore, F-Droid, etc), (Google Play Store, Amazon Appstore, F Droid, etc), 
manually (through ADB or a file manager), from a 
web server, …
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Application Development

 New way of thinking…
• Limited processing powerp g p
• Limited RAM
• Limited permanent storage capacity
• Small screen and low resolution (5”, 10”)
• High cost of data transfer
• Slow data transfer rates with high latency• Slow data transfer rates with high latency
• Unreliable data connections

 OS Manages process lifetime (app assassin)
• App responsiveness
• Setting priority to interaction
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Application Development

 Behaviour Police
5s: Application must respond to pp p

any user action (e.g., key
press) within 5s

10s: A BroadcastReceiver must10s: A BroadcastReceiver must
return from its OnReceive
handler within 10s

** Worst case, not goal!: 

Users notice .5s
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Application Development

 You MUST
• Ensure that your app is ready for swift deathy pp y
• Yet, it must remain response and/or restart in the 

background
• M st come to the fo eg o nd q ickl• Must come to the foreground quickly

 Good behavihour is expected Good behavihour is expected
• Is well behaved
• Switches seamlessly from background to foregroundy g g
• Is polite (e.g., stealing focus)
• Presents a consistent user interface
• Is responsive
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Types of Applications

 Foreground
• Useful when being usedg
• Suspended otherwise

B k d Background
• Apart from when being configured, spends most of 

lifetime hidden (e.g., call screening app)lifetime hidden (e.g., call screening app)

 Intermittent
• Some interaction but mostly in the background (e.g., 

media player)

 Widget
• Home screen status update
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World Market Share - 2009

Linux Android webOS

Windows 
Mobile
9%

5% 4% 1%

Symbian

Symbian
iPhone

9%
BlackBerry

iPhone
47%iPhone

14% Windows Mobile

Android
BlackBerry

20% webOS
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World Market Share – Progression 2009-2012

(Symbian / WebOS / …)( y )

Android Development
Javier Poncela

IoBM – February 2013 20



Android Versions 3Q2012
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Android Versions 3/Jan/2013
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Screen Size & Densities
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Software to Download & Install

1. Java Development Kit (JDK)p ( )
http://www.oracle.com/technetwork/java/javase/downloads/index.html

2 Eclipse IDE for Java2. Eclipse IDE for Java
http://www.eclipse.org/downloads/

3. Eclipse Android Development Tools (ADT) plugin & 
Android Software Development Kit (SDK)

http://developer.android.com/sdk/installing/installing-adt.htmlp // p / / g/ g

4. Add Android platform & other comps to SDK
htt //d l d id / dk/i t lli / ddi k ht lhttp://developer.android.com/sdk/installing/adding-packages.html

5. … Plus a Google account
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Let’s Try…

 Start Eclipse
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Let’s Try…

 Open Window -> Android SDK Manager
• Check installed packagesp g
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Let’s Try…

 Open Window -> AVD Manager
• Shows the list of Virtual Devices
• Allows creating new Virtual Devices
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Let’s Try…

 Select one AVD and Start it!
• First start-up may take a long timep y g
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First App: ‘Hello, World’



Create a new Android Project

 Select File->New->Other… -> Android -> Android 
Application Project
• Application name
• Project name

P k  • Package name
iobm.tutorial.xxxxx

• Build SDKBuild SDK
• Minimum SDK
• Create Activity
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Create a new Android Project

 Select File->New->Other… -> Android -> Android 
Application Project
• Application name
• Project name

P k  • Package name
iobm.tutorial.xxxxx

• Build SDKBuild SDK
• Minimum SDK
• Create Activity
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Hello World Project

 src: source folder

 gen: SDK generated file gen: SDK generated file

 android 2.3.3: reference lib

t  bi   assets: binary resources

 res: resource files and 

resource description files

 AndroidManifest.xml: 

application description file

 default.properties: project 

properties file

 Apk: zip-format
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Say Hello World

 Modify HelloWorld.java
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Import Widget Library

 Click left button on error indication
 Import ‘TextView’ widgetp g
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Run Hello World

 Select HelloWorld Project
a) Right-click, Run as -> Android Application) g , pp
b) Run->Run as->Android Application

 ADT will start a proper AVD and run application on it
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Behind HelloWorld

 R.java, generated by Android SDK, represents all the 
resources of the app
• Resources are all in res folder 
• Resources are pre-compiled into binary format
/* AUTO-GENERATED FILE.  DO NOT MODIFY.
*
* This class was automatically generated by the
* aapt tool from the resource data it found.  It
* should not be modified by hand.
*/
package sample.hello;
public final class R {

public static final class attr {
}
public static final class drawable {

public static final int icon=0x7f020000;
}
public static final class layout {

public static final int main=0x7f030000;
}
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Behind HelloWorld

 res/layout, contains layout declarations of the app in 
XML format
• UIs are built according to the layout file

main.xml
<?xml version="1.0" encoding="utf-8"?>
<LinearLayout

xmlns:android=http://schemas.android.com/apk/res/androidxmlns:android http://schemas.android.com/apk/res/android
android:orientation="vertical"     
android:layout_width="fill_parent"
android:layout height="fill parent">android:layout_height fill_parent >
<TextView

android:layout_width="fill_parent"
android:layout height="wrap content"android:layout_height= wrap_content    
android:text="@string/hello" />

</LinearLayout>
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Behind HelloWorld

 res/values, contains string declarations or other 
values(e.g.:colors) of the app
• string.xml, contains string resources

<?xml version="1.0" encoding="utf-8"?>
<resources>

<string name="hello">Hello World, HelloWorld!</string>
<string name="app_name">HelloWorld</string>

</resources>

referenced in 
res/layout/main.

xml
referenced in 

AndroidManifest.xmlxml AndroidManifest.xml
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Behind HelloWorld

 res/drawable, contains all image resources
• Folders may have suffixes, app will choose the most y , pp

suitable one, so do the other resources
• Three folders: drawable-ldpi, drawable-hdpi, drawable-

mdpi  each contains an icon png filemdpi, each contains an icon.png file
• App will choose the proper icon according to the device 

DPI
• Reference name:@drawable/icon

 Other folders we may use in future
 i ( i ti )  l ( f  d • menu, anim (animation), xml (preference and 

searchable)
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Behind HelloWorld

 AndroidManifest.xml describes the application
• Declare app’s name, version, icon, permission,  etc…pp , , , p ,
• Declare the application's components: activity, service, 

receiver or provider

<?xml version="1.0" encoding="utf-8"?>
<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="sample.hello" android:versionCode="1" android:versionName="1.0">
<application android:icon="@drawable/icon" android:label="@string/app_name">

<activity android:name=".HelloWorld" android:label="@string/app_name">
<intent-filter>

ti d id " d id i t t ti MAIN" /<action android:name="android.intent.action.MAIN" />
<category android:name="android.intent.category.LAUNCHER”/>

</intent-filter>
</activity></activity>

</application>
<uses-sdk android:minSdkVersion="8" />

</manifest>
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Behind HelloWorld

 Basically, an Activity presents a visual user 
interface for one focused endeavor the user can 
undertake

 An application might consist of just one activity or 
several  each Activity is derived from several, each Activity is derived from 
android.app.Activity and should be declared in 
AndroidManifest.xml file

 Each activity is given a default window to draw in, the 
window may be full screen or smaller and on top of 
th  i dother window

 The visual content of the window is provided by a 
hierarchy of views — objects derived from the base hierarchy of views objects derived from the base 
View class
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APK Generation Process

.apk files have
th i f t
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Beyond HelloWorld

 Build up an app that you 
can input your greetings 
and display your 
greetings
• Input: EditText• Input: EditText
• Display: TextView
• Of course, we have to ,

add a button
 Edit res/layout/main.xml 

fil  t  dd th  file to add these 
components
• Each has an android:idEach has an android:id

property, used to 
reference it in code
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Beyond HelloWorld

 Modify HelloWorld.java
• Firstly get the references declared in main.xmly g

• Then add event response for Button
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Beyond HelloWorld

 Finished!
 Run->Run as->Android Applicationpp
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Applications

 By default, each application: 
• Assigned a unique Linux user IDg q
• Executes in its own Linux process

 By default, each process runs its own virtual machine

 Android manages process creation & shutdown
• Starts process when any of the application's code needs p y pp

to be executed
• Shuts down when process is no longer needed and/or 

system resources are required by other applicationssystem resources are required by other applications

 Apps can have multiple entry points 
i  t j t i () th d• i.e., not just main() method

 App comprise components that the system can 
instantiate and run as needed
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Application Components

 Activity
◦ Present a visual user interface for one focused endeavor 

the user can undertake
◦ Example: a list of menu items users can choose from

 Services Services
◦ Run in the background for an indefinite period of time, no 

visual interface
◦ Example: calculate the result to activities that need it

 Broadcast Receivers
◦ Receive and react to broadcast announcements

◦ Example: announcements that the time zone has changed

 Content Providers Content Providers
◦ Store and retrieve data and make it accessible to all 

applications 
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Activities

 Primary class for interacting with user
• Usually implements a focused task y p
• Usually Involves one screen full of data

A i l  A i i  d fi   i l  i bl   A single Activity defines a single viewable screen
• Defines the actions, not the layout
• Example: CalculatorExample: Calculator

 There may be multiple Activities (“Screens”) per 
li iapplication

• Each is a separate entity

 Activities have a structured life cycle
• Different events in their life happen either via the user 

t hi  b tt   ti ll
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Activity Lifecycle

 onCreate() onCreate()

 onStart()

 onResume()

 onPause()

 onStop()

 onDestroy() onDestroy()

 onRestart()
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Activity Lifecycle

 onCreate() — Called when the activity is first created
 onStart() — Called when the activity becomes visible to the 

user
 onResume() — Called when the activity starts interacting 

with the userwith the user
 onPause() — Called when the current activity is being 

paused and the previous activity is being resumed
 onStop() — Called when the activity is no longer visible to 

the user
 onDestroy() — Called before the activity is destroyed by onDestroy() Called before the activity is destroyed by 

the system (either manually or by the system to conserve 
memory)

R t t() C ll d h  th  ti it  h  b  t d  onRestart() — Called when the activity has been stopped 
and is restarting again
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Activity Lifecycle
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Let’s Try… Project Activity101

 Import project
File -> Importp

 Have a look at 
the code
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Let’s Try… Project Activity101

 State changes
are logged
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Let’s Try… Project Activity101

 Do the following (observe 
log after each step):

 A)
• Start the application
• Press Back button

 B) 
• Start the application• Start the application
• Press Home button

o Notice onDestroy is noty
called

• Start the Phone application
• Keep Home button pressed• Keep Home button pressed

o List of recent apps appears
• Choose Activity application
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Lifecycle - Some Comments

 As you can see, an activity is destroyed when you 
press the Back button
• This is crucial, as whatever state the activity is currently 

in will be lost
 Hence  you need to write additional code in your  Hence, you need to write additional code in your 
activity to preserve its state when it is destroyed

 Note that the onPause() event is called both when an 
activity is sent to the background, as well as when it 
is killed when the user presses the Back buttonis killed when the user presses the Back button

 What happens if device configuration changes?
• Orientation, locale, etc

On configuration changes, Android usually kills & 
restarts the current Activity
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Activity Stack

 Applications usually consist of several activities (screens)
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Activity Stack

 Android manages a system Activity stack
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Activity Stack Management

 States
• Not started – not yet createdy
• Active

o Resumed/Running - visible, has focus
P d i ibl  d  t h  f   b  t i t do Paused - visible, does not have focus, can be terminated

o Stopped - not visible, does not have focus, can be 
terminated

• Finished – done
 The OS ranks processes and kills 

those with lowest prioritythose with lowest priority
• We have no control on when an

Activity is destroyed…
o User action
o OS decision (low memory)

•  But changes are notified
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Typical Actions on State Change

 onCreate()
• Activity is being createdy g
• Setup global state

o Call super.onCreate()
I fl t  UI i  o Inflate UI views 

o Configure views as necessary
o Set the activity’s content view

 onPause()
• Focus about to switch to another Activity

o Save persistent state
o Shutdown unneeded behavioro Shutdown unneeded behavior
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Saving Information during Changes in Configuration

 Changing screen orientation destroys an activity and 
re-creates it
• Desirable to keep state, including already made user 

inputs (i.e. text written)

 Preserve state of an activity
• onPause(): use your own mechanismsonPause(): use your own mechanisms
• onSaveInstanceState(): simply preserve the state so that 

it can be restored later
o Simpler
o Provides a Bundle object as an argument
o Fired whenever an activity is about to be killed or put into o Fired whenever an activity is about to be killed or put into 

the background. However, it is not fired when an activity is 
being unloaded from the stack
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Saving Information during Changes in Configuration

 Saving state

 Restoring state: When an activity is re-created, onCreate() is first 
fired, followed by the onRestoreInstanceState() event, which 
enables you to retrieve the state through the Bundleenables you to retrieve the state through the Bundle
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Saving Information during Changes in Configuration
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Finishing an Activity

 Call finish()

 Call setResult(code) with the result code
• Usually RESULT_OK or RESULT_CANCELED and the 

Intent

 Call fi i hA ti it ( tC d ) from caller Call finishActivity(requestCode) from caller
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Intents

 If an application has more than one activity, you may 
need to navigate from one activity to another

 This navigation is accomplished through Intents

 An Intent, is a passive data structure holding an 
abstract description of an operation to be performed
• An ‘simple’ intent consists of two parts • An ‘simple’ intent consists of two parts 

o An action and 
o The data that that action is supposed to use

Intent intent = new Intent(CurrentActivity.this, OtherActivity.class);
startActivity(intent);
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Intents

@O id@Override
public void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R layout main);setContentView(R.layout.main);
// Button listener
Button btnStart = (Button) findViewById(R.id.btn_start);
btnStart setOnClickListener(new View OnClickListener() {btnStart.setOnClickListener(new View.OnClickListener() {

public void onClick(View view) {
Intent intent = 

new Intent(CurrentActivity.this, OtherActivity.class);e te t( u e t ct ty.t s, t e ct ty.c ass);
startActivity(intent);

}
});

}
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Intents

 Intents can be used to:
• Declare your intention that an Activity or Service be y y

started to perform an action, usually with (or on) a 
particular piece of data

• Broadcast that an event (or action) has occurred• Broadcast that an event (or action) has occurred
• Explicitly start a particular Service or Activity

 Most commonly used to start new Activities
• Explicitly:  specifying the class to load

new Intent(CurrentActivity.this, OtherActivity.class);

• Implicitly: requesting that an action be performed on a 
piece of datapiece of data
Intent intent = new Intent(Intent.ACTION_DIAL, 

Uri.parse("tel:555-2368"));
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Intents

 Intent classes are late binding
 This means they are mapped and routed to a y pp

component that can handle a specified task at 
runtime, rather than at build or compile time.

 One Activity tells the platform, “I need a map to 
Granada  GR  ES ” and another component  one the Granada, GR, ES,  and another component, one the 
platform determines is capable, handles the request 
and returns the result. 
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Implicit Intents – Resolution Process

 Components register with the platform to be the 
destination for particular intent types using the 
<intent-filter> element in the AndroidManifest.xml

 When an implicit intent is used, the platform chooses 
the best suitable available componentthe best suitable available component

Android Development
Javier Poncela

IoBM – February 2013 27



Intent Definition

 Intents are made up of three primary pieces of 
information —action, categories, and data— and 
include an additional set of optional elements.
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Implicit Intents – Resolution Process

 When an Intent is requested, resolution takes place 
through the registered filters, using the action, data, 
and categories of the Intent

h h b l There are three basic rules 
• The action must match
• The category must match• The category must match
• If specified, the data type must match, or the 

combination of data scheme and authority and path 
must match
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Implicit Intents – Resolution Process

 Action matching
• The action specified in the Intent object must match one p j

of the actions listed in the filter
• An Intent object that doesn't specify an action 

automatically passes the testautomatically passes the test
• If the filter does not list any actions, there is nothing for 

an intent to match, so all intents with action(s) fail
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Intents – Android Actions
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Implicit Intents – Resolution Process

 Category matching
• Every category in the Intent object must match a y g y j

category in the filter (superset)
• Unlike with actions, an <intent-filter> with no categories 

will match only an Intent with no categories (it is not will match only an Intent with no categories (it is not 
treated as a wildcard).
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Intents – Android Categories
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Will Some App Receive the Intent?

 Call queryIntentActivities() to get a list of 
activities capable of handling the Intent

PackageManager packageManager = getPackageManager();
List<ResolveInfo> activities =

packageManager.queryIntentActivities(intent, 0);
boolean isIntentSafe = activities.size() > 0;
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Resolving Intent Colision

 What happens if another activity (in either the same 
or a separate application) has the same filter name?

 Then the Android OS 
ll d l lwill display a selection

dialog

 So, we don’t have to
worry, the user willy,
choose its preference
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Returning Results from an Intent

 startActivity() invokes another activity but does 
not return a result to the current activity

 Use startActivityForResult() when we want a 
l b kresult back

startActivityForResult(new Intent(ACTION_XXXX), 
request_Code);_

 The returned result must be handled
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Passing Data via Intents

 ‘Bundling’ the data

 ‘Unbundle’ the data
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Specificy How to Handle an Intent

 Intent calls may carry flags to modify default OS 
handling of the Intent

 Some examples
• FLAG_ACTIVITY_NO_HISTORY

o Don’t put this Activity in the History stack
• FLAG DEBUG LOG RESOLUTION• FLAG_DEBUG_LOG_RESOLUTION

o Causes extra logging information to be printed when this 
Intent is processed

 How?

Intent newInt= new Intent(Intent.ACTION_SEND);
newInt.setFlags(Intent.FLAG_ACTIVITY_NO_HISTORY);
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Let’s Try… Project Intents

 Import project

b Web Browser
• User selection dialog

 Make Calls
• Phone number preset
• Change ACTION_DIAL for

ACTION_CALL

 Show Map (Do not Press!!)
• API for maps not installed

 Launch My Browser
• No intent-filter matches
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Displaying Notifications

 Toast: Short persistence notification on screen

Toast.
makeText(this, “Notification text”, 

T t LENGTH SHORT)Toast.LENGTH_SHORT)
.show();

 Notifications: display a persistent message at the top 
of the deviceof the device
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Let’s Try… Project Notifications

 Import Project

 Press button

 Press notification icon
and drag down

 Have a look at the code

 Use a toast
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Let’s Try… Project Notifications

 There are now two activities in the manifest

 PendingIntent
• An Intent that it is not yet launched, but it is prepared

to be launched in the future

Intent i = new Intent(this, NotificationView class);Intent i  new Intent(this, NotificationView.class);
i.putExtra(“notificationID”, notificationID);
PendingIntent pendingIntent =

PendingIntent.getActivity(this, 0, i, 0);
// getActivity (context, request code, intent, flags)
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Let’s Try… Project Notifications

 Obtain an instance of the NotificationManager class

 Set the details of the notification
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Let’s Try… Project Notifications

 Display the notification when the button is clicked

 When the user clicks on the notification, the 
NotificationView activity is launched, and the 
notification cancelednotification canceled
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User Interface



Views

 Views: Base class for all visual interface elements
• Common operationsp

o Set properties
o Set focus

Attach Listeners
View
Go Attach Listeners

o Set visibility
Group

 View Groups: 
View
Group

 View Groups: 
Extensions of 
View class that 
can contain 
multiple child 
ViewsViews
• Layouts are 

View Groups
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Views
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Views

 Views are usually defined in XML

 … and then, they are Inflated in the code
• Component is looked for in the predefined elements
• Properties are read
• Component is created
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Views – Widget Toolbox

 Many predefined widgets
• Buttons
• Text field
• Editable text field
• Check box
• Radio buttons
• Toggle Button• Toggle Button
• DatePicker
• TimePicker
• Spinner
• AutoComplete

ll• Gallery
• MapView
• WebView
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Let’s Try… Project BasicViews1

 Import project

 Look at res/layout/main.xml

 Look at code .java

• See response to events

• See response to save button• See response to save button
clicks
o xml: android:onClick
o java: btnSaved_clicked
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Let’s Try… Project BasicViews3

 AutoCompleteTextView
• shows a list of 

completion suggestions 
automatically while the 
user is typinguser is typing

 Method setThreshold
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Let’s Try… Project BasicViews4

 Time and date selection
• TimePicker
• DatePicker

 Have a look at
• xml file

j  di l t• java dialog management

 ImprovementImprovement
• Create two additional

buttons for calling
o Btn1: TimePicker Dialog
o Btn2: DatePicker Dialog
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Let’s Try… Project BasicViews5

 ListView: Displays a list of 
items in a vertically scrolling 
list

h k b h h d ff Check behaviour with different 
Choice modes (lines 23-25)

 Items are obtained from 
resource in strings.xmlg
getResources

 Press ‘s’ in the emulator
setTextFilterEnabled
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Let’s Try… Project BasicViews6

 SpinnerView: Displays one
item at a time from a list and 
enables users to choose 
among them
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Layouts

 Visual structure for a user interface
• Declare UI elements in XML
• Instantiate layout elements at runtime (not recommended)

Linear Layout Relative Layout Grid/Table LayoutLinear Layout Relative Layout Grid/Table Layout
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Linear Layout

 Elements shown in sequence ‘horizontal’ or ‘vertical’
• Android takes care of the arrangementg

/* linear.xml */
<?xml version=“1.0” encoding=“utf-8”?>
<LinearLayout android:orientation=“horizontal”

android:layout_width=“fill_parent”
android:layout_height=“fill_parent”
android:layout_weight=“1”> 
<TextView android:text=“red” />
<TextView android:text=“green” />

/</LinearLayout>
<LinearLayout android:orientation=“vertical”

android:layout_width=“fill_parent”
d id l t h i ht “fill t”android:layout_height=“fill_parent”

android:layout_weight=“1”> 
<TextView android:text=“row one” />

</LinearLayout>
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Relative Layout

 Elements placed in relation to the position of others
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Table Layout

 Groups views into rows and columns
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Layouts can be nested…
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Layouts can be nested…

<LinearLayout
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:gravity="center_horizontal"
android:background="@color/color_1">

<Button android:text="These"<Button android:text These
android:layout_width="wrap_content"
android:layout_height="wrap_content"/>

<Button android:text="Buttons"
android:layout_width="wrap_content"
android:layout_height="wrap_content"/>

<Button android:text="Are"
android:layout_width="wrap_content"
android:layout height="wrap content"/>android:layout_height wrap_content />

<Button android:text="Centered"
android:layout_width="wrap_content"
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Measurement Units

 dp — Density-independent pixel. 160dp is equivalent to one inch 
of physical screen size. This is the recommended unit of 
measurement when specifying the dimension of views in your measurement when specifying the dimension of views in your 
layout. You can specify either “dp” or “dip” when referring to a 
density-independent pixel.

 sp — Scale-independent pixel. This is similar to dp and is 
recommended for specifying font sizes.

 i i i d fi d b / 2 f i h b d h pt — Point. A point is defined to be 1/72 of an inch, based on the 
physical screen size.

 px — Pixel  Corresponds to actual pixels on the screen  Using this  px Pixel. Corresponds to actual pixels on the screen. Using this 
unit is not recommended, as your UI may not render correctly on 
devices with different screen sizes.

HVGA-L：480x320
HVGA-P：320x480

QVGA-L：320x240
QVGA-P：240x320

WVGA-L：800x480
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Common Attributes

 Size
• android:layout_height, android:layout_width

o match_parent/ fill_parent : fill the parent space (minus padding)
o wrap_content: use natural size (plus padding)
o An explicit size with a number and a dimension

• android:layout_weight
o A number that gives proportional sizes

 Alignment
• android:layout_gravity

o How the View is aligned within containing View.
• android:gravity

o How the text or components inside the View are aligned.
• Possible values

o top, bottom, left, right, center_vertical, center_horizontal, center 
(i.e., center both ways), fill_vertical, fill_horizontal, fill (i.e., fill 
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Common Attributes

 Margins (blank space outside)
• android:layout_marginBottom, 

 Padding (blank space inside)
• android:paddingBottom, 

android:layout_marginTop,  
android:layout_marginLeft, 
android:layout_marginRight

android:paddingTop, 
android:paddingLeft, 
android:paddingRight

o Units: dp, sp, … o Units: dp, sp, …
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Creating the User Interface Programmatically

 So far, all the UIs have been created using XML
 But UIs can also be created in code

Android Development
Javier Poncela

IoBM – February 2013 23



Let’s Try… Project UICode

 See main.xml

 See .java code
• Layout is not inflated

• Each element is added
in the codein the code
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Menus

 Options – Primary menu shown when user presses the 
MENU button of the device
• Displayed at the bottom of screen
• May include icons and text

If th    th  6 it   M  it  i  di l d • If there are more than 6 items, a More item is displayed 
that opens an Expanded menu
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Menus

 Context – View-specific menu to be shown when user 
touches and holds the view
• Floating menu that appears when the user performs a 

long-click on an element
• Similar to “right click” menu• Similar to right-click  menu
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Menus

 Submenu or Popup – A menu activated when user 
touches a visible menu item
• Good to provide options for a second part of a 

command/menu item
• Can't be nested: a submenu item can not expand another • Can t be nested: a submenu item can not expand another 

submenu
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Defining Options Menus

 Override method onCreateOptionsMenu()
• Triggered the first time an Activity’s menu is displayedgg y p y

menu.add (groupId, itemId, order, text)

public boolean onCreateOptionsMenu(Menu menu) {
MenuItem mnu1 = menu add(0 0 0 "Item 1”);MenuItem mnu1 = menu.add(0, 0, 0, Item 1 );

{
mnu1.setAlphabeticShortcut('a');
mnu1 setIcon(R drawable ic launcher);mnu1.setIcon(R.drawable.ic_launcher);

}
MenuItem mnu2 = menu.add(0, 1, 1, "Item 2”);
return super.onCreateOptionsMenu(menu);p p ( );

}
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Menu Items

 Shortcut keys

 Checkboxes and radio buttons
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Menu Items

 Icons

 Intents 
• An Intent assigned to a Menu Item is triggered when the 

clicking of a Menu Item isn’t handled by Activity’s clicking of a Menu Item isn t handled by Activity s 
onOptionsItemSelected handler

menuItem.setIntent(new Intent(this, MyOtherActivity.class));
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Updating Menus Dynamically

 Imagine we want to display different menu items in 
different situations
• onCreate… is only called the first time

 Method onPrepareOptionsMenu() is called
immediately before the Menu is displayed

@Override
public boolean onPrepareOptionsMenu(Menu menu) {
super.onPrepareOptionsMenu(menu);
MenuItem menuItem = menu.findItem(MENU_ITEM);

[ ... modify menu items ... ]y

return true;
}
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Handling Menu Selections

 Method onOptionsItemSelected() is called when a 
menu item is selected
• Response to menu selection

// Return false if you item is not handled// Return false if you item is not handled
public boolean onOptionsItemSelected(MenuItem item) {

switch(item.getItemId()) {
case 0: 

[... Perform action ...]
return true;

case 1:
[... Perform action ...]
return true;

default: return false;
}

}
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Context Menus

 Define menu
public void onCreateContextMenu(ContextMenu menu, View v, public void onCreateContextMenu(ContextMenu menu, View v, 

ContextMenuInfo menuInfo){
super.onCreateContextMenu(menu, v, menuInfo);
menu.setHeaderTitle("Context Menu");
MenuItem mnu1 = menu.add(0, 0, 0, "Item 1”);

mnu1.setAlphabeticShortcut('a');
mnu1.setIcon(R.drawable.ic_launcher);

 Handle menu selections

MenuItem mnu2 = menu.add(0, 1, 1, "Item 2”);
}

Handle menu selections
public boolean onContextItemSelected(MenuItem item) {

switch(item.getItemId()) {
case 0: 

[... Perform action ...]
return true;
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Let’s Try… Project Menus

 Import project

 See how

• Context Menu is created

• Item selection is handled

 First menu items has a 
key shortcut (‘a’)

 Radiobuttons belong to a 
separate Group: Group 1
• Menu groups may be• Menu groups may be

enabled/disabled: 
setGroupEnabled()
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Submenus

 Selecting a submenu presents a single floating 
window that displays all of its Menu Items
• Android does not support nested submenus

SubMenu sub = menu.addSubMenu(0, 0, Menu.NONE, "Submenu");
sub.setHeaderIcon(R.drawable.icon);
sub.setIcon(R.drawable.icon);
MenuItem submenuItem = sub.add(0, 0, Menu.NONE, "Submenu Item");
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Defining Menus in XML

 Menus can be defined using XML syntax
• res/menu folder
• Inflate menu resource using MenuInflater in appropriate 

onCreate…Menu() methods
public boolean onCreateOptionsMenu(Menu menu){

MenuInflater inflater = getMenuInflater();
inflater.inflate(R.menu.my_menu, menu);
return true;

• Handling item selection in appropriate 

return true;
}

on…ItemsSelected() methods
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Menu defined in XML

<menu
xmlns:android="http://schemas.android.com/apk/res/android"
android:name="Context Menu">
<item
android:id="@+id/item01"
android:icon="@drawable/menu_item"
android:title="Item 1">

</item>/
<item
android:id="@+id/item02"
android:checkable="true"
android:title="Item 2">

</item>
<item

android:id="@+id/item04"
android:title="Submenu">
<menu>
<item
android:id="@+id/item05"
android:title="Submenu Item">

</item>
</menu>

</item>
</menu>
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Dialogs

 Dialogs are floating
activities

 General-purpose dialogs
• AlertDialog

• Based on Dialog class
g

• ProgressDialog
• Toasts
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Dialogs

 Dialogs are modal
 Block all user input and must be dismissed before the p

user can continue.

 Dialogs share a common structure
• Optional title region: Introduces 

content 
• Content area: text, UI elements, 

text fields, checkboxes, etc...text fields, checkboxes, etc...
• Action Buttons: Typically 

OK/Cancel, indicating the 
preferred optionpreferred option.
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Creating Custom Dialogs

 Create and show… using a reference to a class
• Dialog view is defined as a layoutg y
• Straightforward way but…
• … Dialog is created every time as a new instance

Dialog d = new Dialog(MyActivity.this);
// Set the title// Set the title
d.setTitle("Dialog Title");
// Inflate the layout
d setContentView(R layout dialog view);d.setContentView(R.layout.dialog_view);
d.show();
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Creating Custom Dialogs

 To avoid repeated creation and destruction
• Use showDialog(int)g( )
• It will call

o onCreateDialog(int)
P Di l (i t)o onPrepareDialog(int)

• Instance is created once, can be modified whenever is to
be shown

• … same a Menus

 Managing and Displaying … As menus
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Creating Custom Dialogs – onCreateDialog()

 Same method is called for creation of any dialog
• Switch is used to identify dialogy g

o Example: Show time
static final private int TIME_DIALOG = 1;
...
showDialog(TIME_DIALOG);
...
@Override
public Dialog onCreateDialog(int id) {
switch(id) {

case (TIME_DIALOG) :
AlertDialog.Builder timeDialog = new AlertDialog.Builder(this);
timeDialog.setTitle("The Current Time Is...");
return timeDialog.create();

}
return null;
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Creating Custom Dialogs – onPrepareDialog()

 Modify the dialog just before showing it
o Example: Show time

@Override
public void onPrepareDialog(int id, Dialog dialog) {
switch(id) {

case (TIME_DIALOG) :
SimpleDateFormat sdf = new SimpleDateFormat("HH:mm:ss");
Date currentTime = new  Date(java.lang.System.currentTimeMillis());
String dateString = sdf.format(currentTime);
AlertDialog timeDialog = (AlertDialog)dialog;g g g g
timeDialog.setMessage(dateString);
break;

}}
}

}
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AlertDialog

 Allows to
• Present a message to the user offering them one to g g

three options in the form of buttons (OK/Yes/No/Cancel)
• List options in the form of checkboxes or radio buttons
• P o ide a te t ent  bo  fo  se  inp t• Provide a text entry box for user input.
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Let’s Try… Project Dialog

 Import project

 See code
• See case 0 in onCreateDialog

o Commented code is equivalent
to running code

o See how function calls may bey
linked on an object

• See how dialog buttons are 
createdcreated

• See how clicks are handled
o Multioptions
o Buttons

• Dialog icon + heading
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ProgressDialog

 Show the progress of some activity
• Example: Status of a download, load a webpage, p , p g ,

request information from a server

Start dialog

Sleep for a whileSleep for a while

Close dialog
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Let’s Try… Project Dialog

 Import project

 See code
• Method onClick2

• Use class ProgressDialog and 
show
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ProgressDialog …. Detailed Progress

 It is possible to display progress status in the dialog

 Update when required

progressDialog.setProgress(0);

progressDialog.incrementProgressBy((int)(100/15));

 Note that Dialog is created as before
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Let’s Try… Project Dialog

 Import project

 See code

• See case 1 in onCreateDialog
o Dialog is based now on class

ProgressDialogProgressDialog

• See how progress is updated
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Context

 We have avoided the issue of Context

 A context object provides a reference to some
element (A), so that new actions/elements can be

d f ( )executed in reference to it (A)
• An activity is the reference of a displayed dialog

 When in doubt, use getBaseContext() to get the
context reference
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Working in the Background

 Some tasks are better performed in the background, 
in parallel with other tasks

 Android provides several mechanisms
• Services
• Background threads
• AsyncTasks• AsyncTasks
• Alarms
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Services

 A service is an application in Android that runs in the 
background without needing to interact with the user
• Respond to events even when application is not active
• Executed in the main thread of the application

 Services have a higher priority than inactive Activities, 
so they’re less likely to be killed by the system
• If killed it will be restarted automatically when resources 

are available

E l f  Examples of use
• Update data from/to a server
• Receive long responsesReceive long responses
• Long calculations
• Music players
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Running a Service

 Started
• When it is started by calling startService()
• Usually, a started service performs a single operation and 

does not return a result to the caller
• When the ope ation is done  the se ice sho ld stop itself • When the operation is done, the service should stop itself 

or the caller should do it
• Do not return a result

 Bound
• When it is started by calling bindService()
• Offers a client-server interface that allows components to 

interact with the service, get requests, deliver results
• Runs as long as one application component is bound to itRuns as long as one application component is bound to it
• Multiple components can bind to the service at once. 

Service is destroyed when all of them unbind
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Creating Services

 Extend class Service

D fi  th d

public class MyService extends Service {

@Override
 Define methods

• onCreate
o When first created

@O e de
public void onCreate() {

...
}

o When first created

• onStartCommand
(St t d)

@Override
public IBinder onBind(Intent intent) {

...(Started)
o When start request

return null;
}

@O id• onBind (Bound)
o When bind request

@Override
public int onStartCommand(Intent intent, 

int flags, int startId) {
...
return Service.START_STICKY;

}
}
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Restarting Services

 Restarting behaviour, when service is terminated by
OS, is controlled by onStartCommand() returned value
• START_STICKY: Standard behavior, onStartCommand

will be called any time your Service restarts after being 
terminated by the OSterminated by the OS.
o OS does not redeliver last intent
o For example, services explicitly started and stopped

• START_NOT_STICKY: Used for Services that are started 
to process specific actions or commands. Following 
termination by the OS, it will restart only if there are y , y
pending start calls. 
o For example, services that handle specific requests

• START REDELIVER INTENT: Combination of previous • START_REDELIVER_INTENT: Combination of previous 
two modes
o Recreate service with last intent
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Manifest

 Include a <service> item within the application node

<?xml version="1 0" encoding="utf-8"?><?xml version= 1.0 encoding= utf 8 ?>
<manifest 

xmlns:android=http://schemas.android.com/apk/res/android
package=“iobm.examples.services“>
<application android:icon="@drawable/icon“

android:label="@string/app_name">
<activity android:name=".HelloAndroid“

android:label="@string/app name">android:label @string/app_name >
<intent-filter>

<action android:name="android.intent.action.MAIN" />
<category android:name="android.intent.category.LAUNCHER"/>

</intent-filter>
</activity>

<service android:name=" MyService" /><service android:name .MyService  />

</application>
</manifest> 
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Services – Starting, Stopping, Passing Data

 Prepare Intent (including data to pass)
Intent myIntent = new Intent(MyService ORDER PIZZA);

 Start the Service

Intent myIntent  new Intent(MyService.ORDER_PIZZA);
myIntent.putExtra("TOPPING", "Margherita");

 Start the Service

MyService service= startService(myIntent);

 Stop the Service
• From caller
stopService(new Intent(this, service.getClassName());
stopService(new Intent(this, MyService);

• From self
stopSelf(startId);
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Let´s Try… Project Services

 Import project

 See Manifest file
• Buttons are linked to functions
• Service registration

 Uncomment sections /* Start
Service */
• ServicesActivity java ServicesActivity.java 

o Function startService
• MyService.java

o Function onStartCommand
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Let´s Try… Project Services

 See code ‘ServicesActivity’
• Call to Service
• Passing data (urls)

 See code ‘MyService’
• Retrieving data (urls)
• Result on screen• Result on screen

 My click ‘Back’ and service isMy click Back  and service is
still running
• Toasts appear on screen

Android Development
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Binding Services

 Service must implement onBind()

private final IBinder binder = new MyBinder();

@Override
public IBinder onBind(Intent intent) {public IBinder onBind(Intent intent) {
return binder;

}

public class MyBinder extends Binder {
MyService getService() {

return MyService.this;
}

R t  f t l Bi d ( t d d l )

}
}

 Return a reference to class Binder (or extended class)
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Binding Services

 Activity must be connected to the Service
• ServiceConnection

// Reference to the service
private MyService serviceBinder;

// Handles the connection between the service and activity
private ServiceConnection mConnection = new ServiceConnection() {
public void onServiceConnected(ComponentName className, IBinderpublic void onServiceConnected(ComponentName className, IBinder

service) {
// Called when the connection is made.
serviceBinder = ((MyService.MyBinder)service).getService();

}

public void onServiceDisconnected(ComponentName className) {
// Received when the service unexpectedly disconnects.// Received when the service unexpectedly disconnects.
serviceBinder = null;

}
};
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Binding Services

 Bind the Service

Intent bindIntent = new Intent(MyActivity.this, MyService.class);
bindService(bindIntent, mConnection, Context.BIND_AUTO_CREATE);

 Once the Service has been bound, all its public 
methods and properties are available through the 
serviceBinder object obtained from the 
onServiceConnected handler.onServiceConnected handler.
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Bound Services – Lifecycle
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Let´s Try… Project Services

 Import project

 Uncomment sections /* Bind
Service */
• Re-comment section /* Start

Service */
• ServicesActivity java ServicesActivity.java 

o Function startService
• MyService.java

o Function onStartCommand
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Let´s Try… Project Services

 See code ‘ServicesActivity’
• Call to Service
• ServiceConnection functions

 See code ‘MyService’
• Retrieving data (urls)
• Result on screen• Result on screen

 Click ‘Back’ and service is stillClick Back  and service is still
running
• Toasts appear on screen
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Asynchronous Tasks

 To ensure that your applications remain responsive, 
it’s good practice to move all slow, time-consuming 
operations off the main application thread and onto a 
child thread

 Alternatives
• Use your own Threads  Handlers and synchronization Use your own Threads, Handlers and synchronization 

with GUI
• AsyncTask: provides all above
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Using AsyncTask

 Create a new class extending AsyncTask
AsyncTask<[Input Parameter Type...],

 T k  b  d  Will b  d  

AsyncTask<[Input Parameter Type...], 
[Progress Report Type...], 
[Result Type]>

• doInBackground: Task to be done. Will be executed on 
the background thread
o Use publishProgress method to post progress updates to 

[Input Parameter Type...]

p g p p g p
the UI

o Return the final result for onPostExecute

• onProgressUpdate: Post interim updates to the UI
o Can safely modify UI elements [Progress Report Type...]

• onPostExecute: When doInBackground has completed, 
the return value is passed in
o Update the UI once the asynchronous task has completed

[Result Type]
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o Update the UI once the asynchronous task has completed
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Running an AsyncTask

 When execute is called, Android does the following:
1. runs onPreExecute in the main (UI) thread( )
2. runs doInBackground in a background thread
3. runs onPostExecute in the main (UI) thread

public void onButtonClick(View view) {
new BackgroundTask().execute(editText.getText().toString());

}

class BackgroundTask extends AsyncTask<String, Void, String> {
protected String doInBackground(String... inputs) {

String reply = // do some background stuff...g p y g
return reply; // this gets sent to onPostExecute

}

t t d id P tE t (St i lt) {protected void onPostExecute(String result) {
tv = (TextView)findViewById(R.id.display_view);
tv.setText(result);

}
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Let´s Try… Project Services

 Import project

 See code ‘MyService’
• Class DoBackgroundTask

o Internal methods
• How progress is reported
• How progress is visualized• How progress is visualized
• How finalization is indicated
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Broadcast Receivers

 Android allows broadcasting events
• Battery low, networks available, new data received, y , , ,

incoming phone call, received text message, …

d h d Broadcast receivers are components that respond to 
such events
• Background processesBackground processes

 Events are broadcast as Intents: Broadcast Intentse ts a e b oadcast as te ts oadcast te ts

 Broadcast Receivers must be registered (Manifest) g ( )
indicating (<intent-filter>) which Intents it will 
listen for
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Broadcast Receivers

 Creating a broadcast receiver
• Executed when a broadcast Intent matches the Intent Filter
• Applications don’t have to be running. They will be started 

automatically
public class MyBroadcastReceiver extends BroadcastReceiver {
@Override
public void onReceive(Context context, Intent intent) {

//TODO: React to the Intent received

 Register a broadcast receiver (Manifest)

//TODO: React to the Intent received.
}

}

 Register a broadcast receiver (Manifest)
• Includes action (event) listening for
<receiver android:name=".LifeformDetectedBroadcastReceiver"><receiver android:name .LifeformDetectedBroadcastReceiver >
<intent-filter>

<action android:name="com.paad.action.NEW_LIFEFORM"/>
</intent-filter>
/ i
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Broadcast Intents

 Construct the Intent and broadcast it 
(sendBroadcast)
• Set the action, data and category

Intent intent = new Intent("com.paad.action.NEW LIFEFORM");Intent intent  new Intent( com.paad.action.NEW_LIFEFORM );
intent.putExtra("lifeformName", lifeformType);
intent.putExtra("longitude", currentLongitude);
intent.putExtra("latitude", currentLatitude);

isendBroadcast(intent);
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Native Android Broadcast Actions

 Android broadcasts Intents for many system Services
http://developer.android.com/reference/android/content/Intent.html

Action Description
ACTION_BOOT_COMPLETED Sent when the platform completes booting

ACTION TIME TICK Sent every minute to indicate that time is tickingACTION_TIME_TICK Sent every minute to indicate that time is ticking

ACTION_TIME_CHANGED Sent when the user changes the time

ACTION_TIMEZONE_CHANGED Sent when the user changes the time zone

ACTION_PACKAGE_ADDED Sent when a package is added to the platform

ACTION_PACKAGE_REMOVED Sent when a package is removed from the 
platformplatform

ACTION_BATTERY_CHANGED Sent when the battery charge level or charging 
state changes

ACTION_CAMERA_BUTTON Fired when the camera button is clicked

ACTION_MEDIA_EJECT If the user chooses to eject the external storage 
media, this event is fired first

ACTION_NEW_OUTGOING_CALL Broadcast when a new outgoing call is about to 
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Ordered and Sticky Broadcast Intents

 Ordered broadcasts
• Using sendBroadcast, the Intent will be received by all g , y

registered Broadcast Receivers
o Cannot control the order and cannot propagate results

• When order in which the Broadcast Receivers receive the • When order in which the Broadcast Receivers receive the 
Intent is important, use sendOrderedBroadcast
o sendOrderedBroadcast(intent, null);
o Intent will be delivered to all registered Receivers in order of 

priority. 

 Sticky broadcasts
• Remain in the system until explicitly removed
• New broadcast receivers registrations will receive the event

o sendStickyBroadcast(intent);
removeStickyBroadcast(intent);
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Handling Ordered Broadcasts

 Passing results

public void onReceive(Context context, Intent intent) {
...
tmp = getResultData() != null ? getResultData() : "";
setResultData(tmp + ":Receiver 1:");setResultData(tmp + :Receiver 1: );

}

 Aborting propagation

public void onReceive(Context context, Intent intent) {
...
if (condition && isOrderedBroadcast()) {

abortBroadcast();abortBroadcast();
}
...

}
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Handling Sticky Broadcast

 isInitialStickyBroadcast returns true if the 
receiver is currently processing the held (cached) 
broadcast event

public void onReceive(Context context, Intent intent) {
if (intent.getAction().equals(Intent.ACTION_BATTERY_CHANGED)) {

String age = "Reading taken recently";
if (isInitialStickyBroadcast()) {if (isInitialStickyBroadcast()) { 

age = "Reading may be stale”; 
}
state.setText("Current Battery Level" + String.valueOf(

intent.getIntExtra(BatteryManager.EXTRA_LEVEL, -1))
+ "\n" + age);

}
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Registering Broadcast Receivers

 Static registration
• In Manifest
• Register at boot time or when package is added

 Dynamic registration
• At runtime

registerReceiver unregisterReceivero registerReceiver, unregisterReceiver
o IntentFilter

public void onCreate(BundlesavedInstanceState) {
...
registerReceiver(newReceiver1(),

new IntentFilter(“MyPackage CustomBroadIntent”));new IntentFilter( MyPackage.CustomBroadIntent ));
... 
unregisterReceiver(newReceiver1());

}
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Some More Comments on Event Handling

 onReceive() should be short-lived (< 10s)
• Application must remain responsivepp p
• If event handling take a long time, consider starting a 

Service, rather than performing complete operation in 
onReceive()onReceive()

 BroadcastReceivers can’t start asynchronous 
operationsoperations
• e.g., showing a dialog, binding to a Service, starting an 

Activity via startActivityForResult
• May happen receiver is no longer in memory when 

response is received

 Debugging tip: Log BroadcastReceivers that match an 
Intent

Intent setFlag(FLAG DEBUG LOG RESOLUTION)
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Saving Resources with Broadcast Receivers

 Register the receiver when the activity is visible and 
unregister when not
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Let´s Try… Project Services

 Import project

 Uncomment sections
/* Broadcast Receiver */
• Re-comment sections /* Start

Service */ and /* Bind Service
*//

• ServicesActivity.java 
o Function startService

 See Manifest
• Service registration• Service registration
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Let´s Try… Project Services

 See code ‘ServicesActivity’
• Call to Service
• IntentService is a service that

creates a worker thread
• B oadcastRecei e• BroadcastReceiver

o onReceive
• onResume

o Registers the receiver
• onPause

 See code ‘MyIntentService’
• onHandleIntent
• Log start and end of download

o See log output
• setAction  sendBroadcast
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Activity Lifecycle

 onCreate() onCreate()

 onStart()

 onResume()

 onPause()

 onStop()

 onDestroy() onDestroy()

 onRestart()
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Services Revisited – IntentService

 Handles asynchronous requests on demand on a single 
background thread
• It isn't affected by most user interface lifecycle events

 Limitations
• Can't interact directly with your user interface

o To update UI, send results to Activity via Broadcast Receiver
• Work requests run sequentiallyWork requests run sequentially
• An operation can't be interrupted

 Provides default implementation ofp
• onBind(): returns null
• onStartCommand(): sends intent to work queue

 Requires to implement 
• Constructor
• onHandleIntent(): It is run automatically on a thread
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IntentService

 Create service
public class RSSPullService extends IntentService {

protected void onHandleIntent(Intent workIntent) {protected void onHandleIntent(Intent workIntent) {
String dataString = workIntent.getDataString();
// Do work here, based on the contents of dataString
...

}
}

 Call service
mServiceIntent = new Intent(getActivity(), RSSPullService.class);
mServiceIntent.setData(Uri.parse(dataUrl));

 Receive result/update

getActivity().startService(mServiceIntent); 

Intent localIntent =
new Intent(Constants.BROADCAST_ACTION)

.putExtra(Constants.EXTENDED_DATA_STATUS, status);
LocalBroadcastManager getInstance(this) sendBroadcast(localIntent);
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User Preferences

 Android provides the Shared Preferences mechanism 
to help save simple application data
• Application settings: color, font size, URL, contact 

person, user name, password (hidden), …

 Saving to a file may be cumbersome… or to a 
database… use the in-built preferences mechanismp
• Save pairs of key-value

 Android provides a system of permissions to access 
the stored preferences 

P i t• Private
• World Readable
• World Writable

Limited data types
String, boolean, float, 

int, and long 
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Working with SharedPreferences

 Follow these steps
• Get a handle to the SharedPreference object (file ‘name’)j ( )

prefsPrivate =
getSharedPreferences(String name, int accessMode)  

• Get the editor

prefsPrivateEditor = prefsPrivate edit()

• Store values

prefsPrivateEditor  prefsPrivate.edit()

prefsPrivateEditor.putString(

• Commit changes

prefsPrivateEditor.putString( 
SharedPrefTestInput.KEY_PRIVATE, 
inputPrivate.getText.toString());

• Commit changes

prefsPrivateEditor.commit();
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Let’s Try… Project SharedPreferences

 Import the project

 4 permission modes
• 3 basic + 1 combined (R/W)

 See code SharedPrefTestInput
C• onCreate

o Strings for preferences
o Variables
o Preference setting process

S d Sh dP fT tO t t See code SharedPrefTestOutput
• How to retrieve stored

preferences
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Retrieving Shared Preferences

 From the same application
• All preferences are accessible, independent of itsp , p

permission

F th li ti From other application
• Access depends on permission

o Private: Noo Private: No
o World_Readable: Only reading
o World_Writable: Only writing

 How to retrieve a preference
• ‘default’: returned if preference not found/accessibledefault : returned if preference not found/accessible

getString(String key, String default)
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Where Are Preferences Stored?

 Preferences are stored as XML files in the 
/data/data/PACKAGE_NAME/ shared_prefs path 
• Every application or package has its own user ID 
• Linux like access permissions

 Tricky part: The path is built from the Context. So, to 
get files from another application you have to know g pp y
and use that application’s Context

createPackageContext(“package.example.prefs", 
Context MODE WORLD WRITEABLE);
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Let’s Try… Project GetSharedPreferences

 Import the project

 See code
SharedPrefTestOtherOutput
• onStart

o Gets context
o Retrieves preferenceso Retrieves preferences

• Compare output with previous
example
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Using Files

 DISCLAIMER: File Storage is very much Java-based

 Creating files
• File will be stored at 

“data/data/[PACKAGE_NAME]/files/file.name”

fos = openFileOutput("filename.txt", Context.MODE_PRIVATE);

 Reading files

fos.write(createInput.getText().toString().getBytes());

 Reading files

fis = this.openFileInput("filename.txt");
b t [] d b t [fi il bl ()]byte[] reader = new byte[fis.available()];
while (fis.read(reader) != -1) {}
this.readOutput.setText(new String(reader));
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Accessing Resource Files

 Files as raw (static) resources (res/raw)
• For example, configuration file at compile timep , g p
Resources resources = this.getResources();
InputStream is = null;
is = resources openRawResource(R raw people);is = resources.openRawResource(R.raw.people);
byte[] reader = new byte[is.available()];
while (is.read(reader) != -1) {}
this readO tp t setTe t(ne String(reader))

 XML file resources (res/xml)

this.readOutput.setText(new String(reader));

XmlPullParser parser = 
this.getResources().getXml(R.xml.people);
StringBuffer sb = new StringBuffer();g g ()
try {
while (parser.next() != XmlPullParser.END_DOCUMENT) {

...
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External Storage

 SD card
• Standard java.io.File and related objects can be used to j j

create, read and remove files on the /sdcard path

File sdCard = Environment.getExternalStorageDirectory();
File directory = new File (sdCard.getAbsolutePath() + “/MyFiles”);
File file = new File(directory, “textfile.txt”);
FileInputStream fIn = new FileInputStream(file);

• Manifest

InputStreamReader isr = new InputStreamReader(fIn);

• Manifest
<uses-permission

android:name=”android.permission.WRITE_EXTERNAL_STORAGE”>
/ i i</uses-permission>
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Let’s Try… Project FileStorage

 Import the project

 Several activities to demonstrate
filesystem access
• Begin with first activity
• Go up to the last one

 XML file read XML file read
<people>
<person firstname="John" lastname="Ford" />
<person firstname="Alfred" lastname="Hitchcock" />
<person firstname="Stanley" lastname="Kubrick" />
<person firstname="Wes" lastname="Anderson" />
</people>
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Eclipse File Explorer

 Show file system in device
 Transfer files to/from device/
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Databases

 For saving relational data, a database is much more 
efficient
• For example, contact information 

 Android uses the SQLite database system

Th  d t b  t d f   li ti  i  l   The database created for an application is only 
accessible to itself
• Other applications will not be able to access itOther applications will not be able to access it

 The SQLite database created programmatically is Q p g y
stored in the /data/data/<package_name>/databases 
folder
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Creating the DBAdapter Helper Class

 Encapsulate the complexities of accessing the data
• Makes access transparent id name emailp

to the calling code
• If the database changes, 

no need to update code

_id name email
15 Ritoo rkhan@edu.pk
27 Umair uahmed@edu.pkno need to update code

 Steps

12 Kumar kumar@edu.pk

Steps
• Define constants for each field of the database
• Create class DatabaseHelper extending 

SQLiteOpenHelper
o Override onCreate and onUpdate

• Define toDefine to
o Open, close, insert contact, delete contact, get contact, get 

all contacts, update contact

Android Development
Javier Poncela

IoBM – February 2013 18



Using the Database

db.open();

// I t// Insert
id = db.insertContact(“Aamir Ahmed”, “ahmed@edu.pk”);

// i// Retrieve
Cursor c = db.getContact(2);
if (c.moveToFirst())
DisplayContact(c);

// Update
db.updateContact(1, “Aamir Ahmed”, “ahmed@edu.pk”);

// Delete
db.deleteContact(1)

db.close();
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Let’s Try… Project Databases

 Import the project

 Run it once

 See code Databases
• onCreate

o Some blocks are commented
o Uncomment and set parameters

at will
o Run again

S d Ad t See code Adapter
• Includes the DatabaseHelper
• Includes functions to query and modify the database
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Mobility, Location, Mapping

 Mobile applications can benefit from being location-
aware, e.g.,
• Routes from current to desired location
• Searching for stores near a current location

Di l i  i f   b  • Displaying info on nearby resources

 Android allows applications to determine & manipulate  Android allows applications to determine & manipulate 
location
• Define map-based Activities using Google Maps
• Use Overlays you can annotate maps and handle user 

input to contextualize map display
• Use Location Based Services (LBS) to• Use Location-Based Services (LBS) to

o Pinpoint geographic locations
o Convert between coordinates and real-world addresses
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Location Representation

 A location represents a position on Earth
 A Location instance consists of:

• Latitude, longitude, a UTC timestamp 
• Optionally, altitude, speed, and bearing
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Location Based Services
(LBS)( )



Using Location Based Services

 LBS is an umbrella term used to describe the different 
technologies used to find a device’s current location

 The two main LBS elements are
• Location Manager: Provides hooks to LBS services
• Location Providers: Location-finding technology

 Using the Location Manager it is possible to
• Obtain current locationObtain current location
• Track movement
• Set proximity alerts for detecting movement into and 

out of a specified area
• Find available Location Providers
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Location Providers

 Multitude of location sources
• GPS

o Most accurate: 1-5 meters
o Only works outdoors

Quickly consumes battery powero Quickly consumes battery power
• Cell-ID

o Determine user location according to connected cell phone 
tower

o Very low accuracy due to large coverage area of cell tower
o Requires no extra battery powero Requires no extra battery power

• WiFi
o Determine user location according to recorded location of 

WiFi APsWiFi APs
o Only available if Google has recorded WiFi location
o Accuracy: ~60 m
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Selecting a Location Provider

 Find available providers

List<String> providers locationManager getProviders(true);

- LocationManager.GPS_PROVIDER, LocationManager.NETWORK_PROVIDER

List<String> providers = locationManager.getProviders(true);

 Find providers using criteria
String bestProvider;

Criteria criteria = new Criteria();
criteria.setAccuracy(Criteria.ACCURACY_COARSE);
criteria.setPowerRequirement(Criteria.POWER_LOW);
criteria.setAltitudeRequired(false);
criteria.setBearingRequired(false);
criteria.setSpeedRequired(false);
criteria setCostAllowed(true);criteria.setCostAllowed(true);

bestProvider = locationManager.getBestProvider(criteria, true);
List<String> matchingProviders = 
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Finding the Location

 Access the Location Manager and get and instance of 
the Service

String serviceString = Context.LOCATION_SERVICE;
LocationManager locationManager;
locationManager = (LocationManager)getSystemService(serviceString);

 Set appropriate permissions in the Manifest file

locationManager = (LocationManager)getSystemService(serviceString);

<uses-permission android:name=
“android.permission.ACCESS_FINE_LOCATION"/>  /* GPS */

<uses-permission android:name=

 Get last location fix

p
"android.permission.ACCESS_COARSE_LOCATION"/> /* Network */

 Get last location fix

String provider = LocationManager.GPS_PROVIDER;
Location location = locationManager getLastKnownLocation(provider);
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Emulating the Location

 Location-based services are dependent on device 
hardware to find the current location

 When developing and testing it is possible to emulate 
the location information

h l l d Open the Emulator Control window
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Emulating the Location

 Manual introduction
• Decimal or sexagesimal

 Lists of points
• GPX (GPS eXchange format)• GPX (GPS eXchange format)
• KML (Keyhole Markup

Language)

Description Latitude
Degrees

Longitude
degrees

Latitude
decimal

Longitude
decimal

Karachi, Pakistan 24º53’38”N 67º1’42”E 24,894 67,028
Mount Everest, Nepal 27°59’ N 86°56’ E 27,983 86,933
Ayer’s Rock, Australia 25°23’ S 131°05’ E -25,383 131,083
G ld G t B id C lif i 37°49’ N 122°29’ W 37 816 122 483
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GPX example

Individual points
+ 

Tracks
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KHL example
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Create new Android Virtual Device (AVD)

 Displaying maps in Android
requires virtual devices with
Google APIs enabled

 Steps to create a new AVD
I  E li  Wi d  AVD • In Eclipse: Window -> AVD 
Manager

• Click New
• Give a name
• Select Target: Google APIs
• Set SD card size
• Skin: WVGA800
• Hardware: If additional• Hardware: If additional

hardware must be emulated
• Click Create AVD
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Let’s Try… Project WhereAmI

 Import project

 Set location using Manual 
coordinates
• GPS icon activates• GPS icon activates

 Run project

 See Manifest
• <uses permission> clause• <uses-permission> clause

 See code LBSActivity
• onCreate

o Use of Location Manager
Obtain last known location
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Tracking Movement

 Use a LocationListener to get updates whenever 
location changes, via requestLocationUpdates method 
• As battery might be a concern, operation can be 

optimized by specifying the minimum time and the 
minimum distance between location change updatesminimum distance between location change updates

int t = 5000; // milliseconds
int distance = 5; // meters

LocationListener myLocationListener = new LocationListener() {
public void onLocationChanged(Location location) { ... }
public void onProviderDisabled(String provider){ ... }public void onProviderDisabled(String provider){ ... }
public void onProviderEnabled(String provider){ ... }
public void onStatusChanged(String provider, int status,

Bundle extras){ ... }  /* HW status changed */
};

locationManager.requestLocationUpdates(provider, t, distance,
myLocationListener);
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Let’s Try… Project WhereAmI

 Import project

 Set location using Manual 
coordinates
• Run project• Run project
• Update location

 See code LBSActivity
• onCreate

o Selection of Location
Provider based on criteria

o Obtain last known location
o Listener registration

• LocationListener
Implementation
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Geocoding

 Geocoding lets you translate between street addresses 
and longitude/latitude map coordinates
• Forward: Finds the latitude and longitude of an address
• Reverse: Finds the street address for a given latitude and 

longitudelongitude
 Comments

• Geocoding lookups are done on the server, requires Geocoding lookups are done on the server, requires 
Internet permission
<uses-permission android:name="android.permission.INTERNET"/>

• Geocoder lookups are performed synchronously  so they • Geocoder lookups are performed synchronously, so they 
will block the calling thread

• Geocoding functions return a list of Address objects
• Localize your results

Geocoder geocoder = new Geocoder(getApplicationContext(),
L l tD f lt())

Android Development
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Reverse Geocoding

 Returns street addresses for physical locations, 
specified by latitude/longitude pairs
• Accuray will, of course, depend on the quality of 

database data

location = locationManager.getLastKnownLocation
(LocationManager.GPS_PROVIDER);

double latitude = location.getLatitude();
double longitude = location.getLongitude();

List<Address> addresses = null;List<Address> addresses = null;

Geocoder gc = new Geocoder(this, Locale.getDefault());
try {
addresses = gc.getFromLocation(latitude, longitude, 10);

} 
catch (IOException e) {}
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Forward Geocoding

 Determines map coordinates for a given location
• Valid location 

o Regular street addresses, postcodes, train stations, 
landmarks, named buildings, hospitals, …

List<Address> result = geocoder.getFromLocationNameg g
(aStreetAddress, maxResults);

Geocoder fwdGeocoder = new Geocoder(this, Locale.US);Geocoder fwdGeocoder  new Geocoder(this, Locale.US);
String streetAddress = "160 Riverside Drive, New York, New York";

List<Address> locations = null;

try {
locations = fwdGeocoder.getFromLocationName(streetAddress, 10);

}} 
catch (IOException e) {}
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Let’s Try… Project WhereAmI

 Import project

 Set location using Manual 
coordinates
• Lat: 24 894  Long: 67 028• Lat: 24,894, Long: 67,028
• Run project

 See Manifest
• <uses-permission> clause

 See code LBSActivity
• updateWithNewLocation• updateWithNewLocation

o Geocoding
o Response handling
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Map-based Activities

 A map-based activity will, at least, use the following 
elements
• MapActivity: The base class you extend to create a new 

Activity. 
• MapView: The Map View control  Only can be used • MapView: The Map View control. Only can be used 

within a MapActivity
o Present geographical data
o Interact with the map
o Modes: Street, satellite, traffic
o Annotation using Overlayso Annotation using Overlays

 Using maps requires
• Virtual Device with Google Maps enabled
• A Google Maps API Key
• Additional permissions
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Obtaining Google Maps API Key

 Without an API key the Map View will not download the 
tiles used to display the mapp y p
• Need a Gmail account

 Use the SDK Debug certificate
• For development

Emulator or local connected o Emulator or local connected 
device

• Key valid for all projects 
h / llin same machine/installation 

(apply only once)
• Default debug keystoreDefault debug keystore

o debug.keystore

o Windows -> Preference 
-> Android -> Build
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Obtaining Google Maps API Key

 Steps
• Instructions

https://developers.google.com/maps/documentation/android/v1/mapkey

• Get the MD5 certificate of your signing certificate
> "c:\Program Files\Java\jre6\bin\keytool exe" -list -alias> c:\Program Files\Java\jre6\bin\keytool.exe  -list -alias 
androiddebugkey -keystore
\users\<username>\.android\debug.keystore -storepass <password> -
keypass <password>

>> Certificate fingerprint (MD5):
94:1E:43:49:87:73:BB:E6:A6:88:D7:20:F1:8E:B5:98

• Get the keyy
https://developers.google.com/maps/documentation/android/v1/maps-
api-signup

o Accept termso Accept terms
o Introduce MD5  0pg7mjTX7wgDpmV-iG8aaq2_paA3an0DYp2VYLg

• Insert the key in the layout file
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Using Maps

 Layout with MapView

<com.google.android.maps.MapView
android:id="@+id/myMapView"
android:layout_width="fill_parent"
android:layout_height="fill_parent"
android:enabled="true"
android:clickable="true"
android:apiKey="myMapKey"

/>

 Changes in Manifest
• Add the library in the application nodeAdd the library in the application node

<uses-library android:name="com.google.android.maps"/>
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Using MapViews

 Default: Street map
• Other views are possiblep

mapView.setSatellite(true); 
mapView.setStreetView(true);

Vi tT ffi (t )

 Display zoom controls

mapView.setTraffic(true);

mapView.setBuiltInZoomControls(true);
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Map Controller

 Use Map Controller to pan, move and zoom a MapView
MapController mapController = myMapView.getController();MapController mapController  myMapView.getController();

 Map locations are represented by GeoPoint objectsp p y j
• Latitude and longitude measured in microdegrees
Double lat = 37.422006*1E6;
Double lng = -122.084095*1E6;
GeoPoint point = new GeoPoint(lat.intValue(), lng.intValue());

 Re-center, move and zoom the Map View
mapController.setCenter(point);
mapController.animateTo(point);
mapController.setZoom(1);

Note: Zoom = 1  most distant view; Zoom = 21 nearest view
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Let’s Try… Project WhereAmIMaps

 Import project

 Get Google Maps API key

 Update GPS position beforeUpdate GPS position before
running

S \l t\ i l See res\layout\main.xml
• Insert key
• MapView elementMapView element

 See Manifest
• <uses-library>
• <uses-permission>
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Let’s Try… Project WhereAmIMaps

 See code WhereAmI.java
• Based on MapActivityp y
• onCreate

o MapView controls
& configuration& configuration

• mapController

 Others
• Click on map to get

zoom controls
• Send new coordinates

to move the mapto move the map
o Try small differences

• Change map mode
/
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Overlays

 An overlay is a canvas with a transparent background 
that is layered onto a Map View
• Enable to add annotations and click handling to 

MapViews
• Can add as many Overlays as wished onto a single map• Can add as many Overlays as wished onto a single map

 How?How?
• Extend class Overlay
• Override draw(…) method

o Draw the shape wanted
• Override onTap(…) method

React to user clickso React to user clicks
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Projections

 The canvas represents the visible display surface
 Projections translate between latitude/longitude j / g

coordinates (stored as GeoPoints) and x/y screen 
pixel coordinates (stored as Points)

Point myPoint = new Point();

Projection projection = mapView.getProjection();

// To screen coordinates
projection.toPixels(geoPoint, myPoint);
// To GeoPoint location coordinates
projection.fromPixels(myPoint.x, myPoint.y);p j ( y , y y);
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Drawing on the Canvas

 The canvas represents the visible display surface
public void draw(Canvas canvas, MapView mapView, boolean shadow) {public void draw(Canvas canvas, MapView mapView, boolean shadow) {
Point myPoint = new Point();
projection.toPixels(geoPoint, myPoint);

// i// Create and setup your paint brush
Paint paint = new Paint();
paint.setARGB(250, 255, 0, 0);
paint.setAntiAlias(true);paint.setAntiAlias(true);
paint.setFakeBoldText(true);

// Create the circle
i d 5int rad = 5;
RectF oval = new RectF(myPoint.x-rad, myPoint.y-rad,
myPoint.x+rad, myPoint.y+rad);

// Draw on the canvas
canvas.drawOval(oval, paint);
canvas.drawText("Red Circle", myPoint.x+rad, myPoint.y, paint);

}
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Handling Tap Events

 Override onTap(…)
• Parameters

o Geopoint
o The MapView

public boolean onTap(GeoPoint point, MapView mapView) {
// Perform hit test to see if this overlay is handling the click
if ([ . . . perform hit test . . . ]) {

[ . . . execute on tap functionality . . . ]
return true;

}}

// If not handled return false
return false;

}
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Adding and Removing Overlays

 Each MapView contains a list of Overlays currently 
displayed
• Adding and removing items from the list is thread-safe 

and synchronized
 To add an Overlay onto a Map View  create a new  To add an Overlay onto a Map View, create a new 

instance of the Overlay and add it to the list

List<Overlay> overlays = mapView.getOverlays();
MyOverlay myOverlay = new MyOverlay();
overlays.add(myOverlay);

 Call postInvalidate() to redraw the MapView

mapView.postInvalidate();

 Call postInvalidate() to redraw the MapView
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Itemized Overlays

 Convenient shortcut for adding markers to a map, 
letting you assign a marker image and associated text 
to a particular geographical position
• Handles the drawing, placement, click handling, focus 

control  and layout of each markercontrol, and layout of each marker

List<Overlay> overlays = 
mapView.getOverlays();

MyItemizedOverlay markers;
iMarkers = new MyItemizedOverlay

(r.getDrawable(R.drawable.marker));
overlays.add(markers);
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Let’s Try… Project WhereAmIMaps

 Import project

 See code WhereAmIMaps
• onCreate

o Overlay creation

 See code MyPositionOverlay See code MyPositionOverlay
• draw method
• onTap should check useronTap should check user

clicked on the overlay
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WindWaves

 Display buoy information
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Let’s Try… Project WindWaves

 Import project

 Run and test it briefly

Manifest

 Indication of main entry point
 List of all activities in the application
 Permission for Internet access
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Buoy Data Structure

 BuoyData.java
• Stores data of a buoyy
• toString

 BuoyOverlayItem.java
• Stores the points to draw in the map

LocationHelper.java

 Auxiliary functions to
 Create geoPointCreate geoPoint
 Parse geoRssPoint
 Parse coordinates
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styles.xml

 Located in res/values

 It is possible to define styles to draw elements
• Texts, backgrounds, borders, …
• Just reference the style to use in each item
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StartActivity.java

 Entry point

 Layout: startactivity.xml
• ScrollView with a RelativeLayout with 3 items

 Starts a thread to delay entering the next activity
h i i ll i i• When time expires, call startActivity
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MapViewActivity.java

 Main activity (it’s a MapActivity)
• Layout: mapview_activity.xmly p y

 onCreate
• Load marker icon
• Create list of OverlayItems

 onStart
• Get location  animate to itGet location, animate to it
• Get bouy data

 Options Menu
• onCreateOptionsMenu
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MapViewActivity.java

 getBuoyData
• Show progress dialogp g g
• Create new thread and call class to retrieve data
• Parse the list of received buoys
• Update UI (handler)

 getBuoyOverlayItemsge uoyO e ay e s
• Create list of buoy Overlays

h dl handler
• Update list of buoy Overlays
• Redraw mapRedraw map

 LocationListener

Android Development
Javier Poncela

IoBM – February 2013

• Listen to location updates
10



BuoyItemizedOverlay.java

 To represent overlays on the map

 draw
• Relies on super, as it provides an image for the marker

 onTap
di l i h i f li k d b• Presents dialog with extra info on clicked buoy

• Loads layout buoy_selected.xml
o Styles usedo Styles used
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BuoyDetailActivity.java

 Shows more detail on buoy
• Layout: buoydetail_activity.xmly y y

 Calls activity to display buoy URL

startActivity(new Intent(Intent.ACTION_VIEW,
Uri.parse(BuoyDetailActivity.buoyData.link))); 
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NDBCFetcher.java

 Retreives buoy data from server
• Creates queryq y
• Sends request to the server
• Creates reader and parser
• Assigns handler to parser
• Initiates parsing
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NDBCHandler.java

 Parses retrieved information from server

 Main functions
startDocument

• startDocument: start processing
• startElement: creates Buoy entry
• endElement: sets job attributes

startElement

• endElement: sets job attributes
• endDocument: finish processing
• characters: parses tokens

endElement

p
endDocument
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List of Items

 Screen 1
• Introduce item + Detail + Name Add

URL
• Button Add  Show list

S 2

Detail

URL



 Screen 2
• Show list of items
• Clicking item  get Details

List Item 1

List Item 2Clicking item  get Details
 Screen 3

• Show details + Button

List Item 2
List Item 3

• Click button  show webpage List Item 4

List Item 5

List Item 6
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Calculator

 Basic implementation
• Some digits

1 2
g

• One simple operation
• One complex operation

1 2

3 4

+

!
 Operands are shown in text

boxes when number is input
 For the complex operation

3 4 !

5 6 =
 For the complex operation

use
• ProgressDialog

Op1
g g

• AsyncTask
• … update progress (sleep

bet een calc lation c cles)

Op2

Result
between calculation cycles)
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Further…

http://developer.android.com/guide/components/index.html
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Further…
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